Switchboard User Manual
Version 1.2

Operator Consol Software Application for 8x8 Virtual Office
Contents

Introduction ....................................................................................................................................... 3
   System Requirements ........................................................................................................... 3

Getting Started ................................................................................................................................. 3
   Installation ................................................................................................................................. 3

On-Screen Organization ................................................................................................................ 4
   Window Display ...................................................................................................................... 4
   Directory Area .......................................................................................................................... 5
   Reminder/Notebook Area ................................................................................................... 5
   Menu Bar .................................................................................................................................... 6

Managing Active Calls .................................................................................................................... 9
   Answering an Incoming Call .............................................................................................. 9
   To answer an incoming call: ..............................................................................................10
   Placing and Retrieving a Call on Hold ..........................................................................10
   To manually put a call on hold: ........................................................................................10
   Alternative manual methods: ...........................................................................................10
   Transferring a Call .................................................................................................................10
   To transfer a call: ....................................................................................................................10
   Announcing a Call ................................................................................................................11
   To announce a call: ...............................................................................................................11
   Retrieving an Announced Call .........................................................................................12
   To re-activate the incoming call: ......................................................................................12
   Transferring a Call Directly to Voicemail ......................................................................12
   To transfer a call to Voicemail, in the Active Calls area: ...........................................12
   Making an Internal Call ......................................................................................................13
   To call within the organization, the simplest way is to: ..............................................13
   To call within the organization: .......................................................................................13
   Leaving an Internal Message.............................................................................................13
   Holding a Call for a Person ................................................................................................13
   Activating the Auto-Attendant ........................................................................................14
   To activate the Auto-Attendant: ......................................................................................14
   Deactivating the Auto-Attendant ......................................................................................14
   To deactivate the Auto-Attendant: ..................................................................................14
   Directed Hold .........................................................................................................................14

Preferences Window .....................................................................................................................14
   Resizing the Windows .........................................................................................................16
   To move either divider: .......................................................................................................16
   Miscellaneous System Numbers .....................................................................................17
**Introduction**

The Switchboard Application is an optional receptionist/operator console software application for 8x8 Virtual Office that will increase the efficiency of your organization with better phone call management. Switchboard allows:

- Multiple call viewing and handling
- Direct transfer to extension's Voicemail
- Supervised call transfers
- View of extensions’ status

The Virtual Office switchboard is flexible and easy-to-use. It does not require advanced computer applications knowledge or experience. With a few clicks of a PC’s mouse, a receptionist can transfer a call, put a caller on hold and announce the caller to an intended recipient or search the organization’s directory.

**System Requirements**

To operate your switchboard, you must have the following requirements on your computer:

- Windows 98, NT, 2000 or XP operating system
- 128 MB of RAM
- 200 MB of free disk space
- 10/100 Base-T Ethernet connection

**Getting Started**

Upon subscribing to the Switchboard application, you will be provided a link to the software within your confirmation letter. The confirmation letter also provides step-by-step download and installation instructions to guide you through the Switchboard installation process.

**Installation**

The Switchboard application must be installed on the local computers that will be using the Switchboard Application before the Switchboard will work. Additional concurrent Switchboard subscription licenses must purchased for any additional number of con-current Switchboard sessions that will be run on different computers. A user can install Switchboard on several computers and share one subscription license as long as only one concurrent session is running. Follow the instructions to install and set up the Switchboard Application.
Using Switchboard
To run the Switchboard application follow the instructions below:

Double-click on the Switchboard icon.

Your user login screen will appear.

On-Screen Organization

Window Display
The Switchboard window display is divided into three main areas:

Active Calls Area
» Use this section for call viewing and:
  - Answering
  - Holding
  - Ending
  - Transferring
  - Announcing
  - Directing to Voicemail

Within the Active Calls Area is the “directed hold” column, a place for the operator to see the current status of the calls in progress.
Directory Area

» Each extension has 4 fields for:
  - Firstname*
  - Lastname*
  - Ext*

  » Status
  - Green Dot (extension in use)
  - DND (do not disturb)
  - OUT (extension not in service)

*These fields can be sorted on screen.

» Use this section to:
  - Easily locate extensions, names and status
  - Place internal call
  - Leave a Voicemail

» Use this section to move active calls:
  - Transfer-
  - Announce (supervised) transfer
  - Direct to Voicemail

Reminder/Notebook Area

» Use this section to:
  - Store messages for the organization
  - Make personal notes
Menu Bar

Switchboard’s menu bar has six options (File, Edit, Call, Directory, Tool and Help) which gives you access to pull-down menus. These entries control all aspects of the application.

Note: Command options in the menus and the Toolbar will only be highlighted or “live” when they are available and can be used in the current situation.

1. The **File Menu** has controls for the reminder/.notebook functions and permits program exit.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save reminder</td>
<td>Saves the reminder entry</td>
</tr>
<tr>
<td>Save note book</td>
<td>Saves the note book entry</td>
</tr>
<tr>
<td>Reset note book</td>
<td>Clears the note book entry</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Switchboard Application</td>
</tr>
</tbody>
</table>

2. The **Edit Menu** provides standard cut, copy and paste functions and allows preference changes.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts selected text from the reminder/notebook section</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies selected text in the reminder/notebook section</td>
</tr>
<tr>
<td>Paste</td>
<td>Sticks selected text into the reminder/notebook section</td>
</tr>
<tr>
<td>Preferences</td>
<td>Options for configuration, layout and colors.</td>
</tr>
<tr>
<td></td>
<td><em>(See page 13 for complete details.)</em></td>
</tr>
</tbody>
</table>
3. The **Call Menu** gives options for a call: hold, transfer, forward, conference, Voicemail and end.

![Image 7: Drop-down Call Menu]

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold for me</td>
<td>Places the selected call on hold</td>
<td>F1</td>
</tr>
<tr>
<td>End Call</td>
<td>Ends the selected call</td>
<td>F3</td>
</tr>
<tr>
<td>Forward all calls to</td>
<td>Forwards all incoming calls to the Auto-Attendant</td>
<td>F9</td>
</tr>
<tr>
<td>Auto-Attendant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Call this person</td>
<td>Places a call to the selected directory entry</td>
<td>F7</td>
</tr>
<tr>
<td>Leave voicemail</td>
<td>Leaves a voicemail message for the selected directory entry</td>
<td>F5</td>
</tr>
<tr>
<td>Announce the caller</td>
<td>Calls the selected person and allows announcement of the incoming call, while placing the active call on hold</td>
<td>F2</td>
</tr>
<tr>
<td>Transfer the call</td>
<td>Transfers the call directly to the selected directory entry</td>
<td>F4</td>
</tr>
<tr>
<td>Voicemail</td>
<td>Accesses the voicemail box</td>
<td>None</td>
</tr>
<tr>
<td>Hold for this person</td>
<td>Places an incoming call on hold for a selected directory entry</td>
<td>None</td>
</tr>
</tbody>
</table>

4. The **Directory Menu** assists in sorting the organization’s directory.

![Image 8: Drop-down Directory Menu]
The **Tool Menu** provides the ability to modify the appearance of the Switchboard display window and to show or hide tool bar buttons.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by First name</td>
<td>Changes the Company Directory to alphabetical ascending order, based on the entry in the <strong>Firstname</strong> column. The <strong>Firstname</strong> column will then appear first in the directory.</td>
</tr>
<tr>
<td>Sort by Last name</td>
<td>Changes the Company Directory to alphabetical ascending order, based on the entry in the <strong>Lastname</strong> column. The <strong>Lastname</strong> column will then appear first in the directory.</td>
</tr>
<tr>
<td>Sort by Extension</td>
<td>Changes the Company Directory to numeric ascending order, based on the entry in the <strong>Ext.</strong> column. The directory will list <strong>Lastname, Firstname, and Extension</strong> number across the screen.</td>
</tr>
</tbody>
</table>

5. The **Tool Menu** provides the ability to modify the appearance of the Switchboard display window and to show or hide tool bar buttons.

### Command | Sub-Command | Description | Note
---|---|---|---
**Look & Feel**

<table>
<thead>
<tr>
<th>Metal Look &amp; Feel</th>
<th>Changes background colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motif Look &amp; Feel</td>
<td>Changes background colors</td>
</tr>
<tr>
<td>Windows Look &amp; Feel</td>
<td>All borders and frames are the standard Windows color. The text is the standard Windows font color and style.</td>
</tr>
</tbody>
</table>

**Call Toolbar**

<table>
<thead>
<tr>
<th>Show</th>
<th>Shows the Call Toolbar buttons above the Active Calls Area.</th>
<th>The Toolbar buttons take up space at the top of the screen. It may be necessary to resize the &quot;Reminder/Notebook&quot; window to show all.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hides</td>
<td>Hides the Call Toolbar buttons.</td>
<td></td>
</tr>
</tbody>
</table>

**Directory Toolbar**

<table>
<thead>
<tr>
<th>Show</th>
<th>Shows the Directory Toolbar buttons above the Active Calls Area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hides</td>
<td>Hides the Directory Toolbar buttons.</td>
</tr>
</tbody>
</table>
6. The Help Menu has application information and tips for problem solving.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Switchboard</td>
<td>Provides version details about the application.</td>
</tr>
<tr>
<td>Help Controls</td>
<td>Opens a browser that contains troubleshooting information.</td>
</tr>
</tbody>
</table>

Managing Active Calls
The Active Calls Area displays all active calls. A button appears on each call displayed, giving the switchboard operator options to answer, hold, transfer or end it. These incoming calls are listed top to bottom in order of appearance. In other words, the most recent calls are displayed at the bottom of the caller list in the Active Calls Area.

Answering an Incoming Call
Incoming calls ring and appear on the computer screen as a button with a telephone symbol.
To answer an incoming call:
1. Pick up the telephone receiver (if not using a headset)
2. Use the mouse to click on the incoming call’s button
3. The call becomes active
4. Speak into your phone handset or headset

Placing and Retrieving a Call on Hold
Circumstances demand that some callers be placed on hold. If you answer an incoming call while talking on another one, the first call will automatically be put on hold.

To manually put a call on hold:
1. Click on the on-screen button for the call you want to hold
2. Click on the Call Menu
3. Select “Hold For Me”
4. The timer shows the length of the call being held.

Alternative manual methods:
- a. Click on the on-screen button for the call you want to hold
- b. Select the “Hold” button on the Toolbar
  Or
- a. Right-click on the incoming call button to display the pop-up menu
- b. Select “Hold For Me”

To retrieve a call on hold:
- a. Click once on the on-screen button for the call on hold
  Or
- a. 1. Right-Click on the button to bring down a menu
- b. 2. Select “Retrieve”

Transferring a Call
Transferring an incoming phone call is a common chore that can be done quickly and easily via Switchboard.

To transfer a call:
1. Click on the on-screen button for the call you want to transfer
2. Move to the Directory and click on the individual who is to receive the call
3. Click on the Call menu

4. Select “Transfer the Call”

**Alternative transferring methods:**

- a. Click on the on-screen button of the call to transfer
- b. Move to the Directory and click on the individual who is to receive the call
- c. Select the “Transfer” button on the Toolbar

Or

- a. Click on the on-screen button of the call to transfer
- b. Move to the Directory and click on the individual who is to receive the call
- c. Select “Transfer the Call”

When the switchboard operator transfers a call, the destination telephone rings and operator’s telephone reverts to a dial tone in North America or a busy tone if in Europe.

**Announcing a Call**

Announcing a call is done when the switchboard operator answers an incoming call and the caller requests to be connected with someone or their extension. The operator calls the requested individual’s extension to inform of the incoming call. Then the call is transferred.

**To announce a call:**

1. If the call is not currently active, click on the on-screen button for the caller you want to announce
2. Move to the Directory and click on the individual who is to receive the call
3. Click on the Call menu
4. Select “Announce the Caller”

**Alternative announcing methods:**

- a. Click on the on-screen button of the call to transfer
- b. Move to the Directory and click on the individual who is to receive the call
- c. Select the “Announce” button on the Toolbar

Or

- a. Click the screen button of the call to transfer
Move to the Directory and click on the individual who is to receive the call
Select “Announce the Caller”
When the intended recipient answers, operator advises of the incoming call
Then right-click on the “Directed Hold” area button to display a pop-up menu
Click on “Transfer”

Both caller and recipient information will disappear from the Active Calls area. The phone reverts to a dial tone in North America or a busy tone if in Europe.

Retrieving an Announced Call
You can continue a dialogue with the incoming caller, after having announced a call. You do this by re-activating the incoming call before you make the final transfer.

To re-activate the incoming call:
1. Right-click on the incoming call button in the “Directed Hold” area to display a pop-up menu
2. Select “Retrieve”
Or
» Simply click on the button directly and the incoming call will become active.
The recipient button will stay in the Active Calls area. The switchboard operator can speak to either the caller or the recipient by clicking on their respective call buttons in the “Active Calls” or “Directed Hold” columns. Transfer as instructed above.

Transferring a Call Directly to Voicemail
Transferring an incoming caller directly to an individual’s or group’s mailbox is simple.

To transfer a call to Voicemail, in the Active Calls area:
1. Click on the on-screen button for the call you want to transfer
2. Move to the Directory and click on the individual who is to receive the message
3. Click on the Call menu
4. Select “Voicemail”

Alternative transferring methods:
a. Click on the on-screen button of the call to transfer
b. Move to the Directory and click on the individual who is to receive the message
c. Select the “Voicemail” button on the Toolbar
Or
a. Click on the on-screen button of the call to transfer
b. Right-click on individual in the Directory who is to receive the message
c. Select “Voicemail”
Making an Internal Call

To call within the organization, the simplest way is to:
1. In the Directory, double-click the name of the individual you want to contact
2. Your own telephone will ring
3. When you answer it, a button with a telephone icon will appear in the Active Calls area on the computer screen

To call within the organization:
1. Click on the individual in the Directory you want to contact
2. Click on the Call menu
3. Select “Call This Person”
4. Your own telephone will ring
5. When you answer it, a button with a telephone icon will appear in the “Active Calls” area on the computer screen (this screenshot would be more relevant if the console section was shown).

Leaving an Internal Message
To leave a message in an individual’s Voicemail box:
1. Click on the individual in the Directory you want to contact
2. Click on the Call menu
3. Select “Leave a Voicemail”

Holding a Call for a Person
To hold a call for a specific person, in the Active Calls area:
1. Click on the on-screen button for the call you want to place on hold
2. Move to the Directory and click on the individual who is to receive the call
3. Click on the Call menu
4. Select “Hold for this person”

Alternative method:
   a. Click on the on-screen button of the call to place on hold
   b. Move to the Directory and right-click on the individual to display the pop-up menu
   c. Select “Hold for this person”
Activating the Auto-Attendant
Switchboard’s Auto-Attendant is the application’s advanced feature that will automatically manage in-coming calls when the operator cannot be present or during after-hours.

To activate the Auto-Attendant:
» Using the Call menu, select “Forward all calls to Auto-Attendant”

Alternative method:
a. Using the Toolbar, click on the “Auto-Attendant” button

Deactivating the Auto-Attendant

To deactivate the Auto-Attendant:
» Using the Call menu, select “Cancel forwarding to Auto-Attendant”

Alternative method:
  a. Using the Toolbar, click off the “Auto-Attendant” button

When the Auto-Attendant is deactivated, the Active Calls area will revert to its normal state.

Directed Hold
When a call is located in the “Directed hold” column, this indicates the caller has been placed on hold by someone at an extension within the organization. The operator can check on the caller if several minutes pass without a change in status.

Preferences Window
You can change the appearance of your Switchboard to suit your own tastes and way of working. Preference options are found under the Edit menu. After selecting Preferences, you will find:
Configuration options are set in the setup module, which is usually run only once, when you are first configuring the application. You cannot change the configuration from the preference window and are only shown for reference. To change the configuration preferences, you will need to run the application setup again. Refer to page 6 and the “Getting Started” section of this manual.

Look & Feel options allow you to choose from three different designs for the application window and let you show or hide the Toolbar buttons.

Layout options allow you to define the size of the Directory and the Reminder/Notebook windows, including the height of the rows. Narrower and shorter columns and rows will allow for more extension listings and messages. As an example the default value of the height of a row is 20 and can be scaled down easily to 13 to permit more rows in the layout.

Color options allow you to choose different shades for all the different areas on the window display. To choose the color for any of the areas shown:

1. Click anywhere in the color rectangle next to the object you want to change
2. Choose a color in the window that appears
   - In Select color window, there are three different tabs that lead to windows, which provide complete control over the colors of your screen layout. They are Swatches, HSB (hue, saturation, brightness) and RGB (red, green, blue).
   - The Swatches window provides about 270 different pre-set colors to choose from. The most recently chosen colors are displayed in the Recent window on the right. To choose a color:
- Click on one of the predetermined colors in the main Swatches area

Or
1. Click on one of the recently used colors on the Recent area.
2. Click on the OK button on the Swatches window
3. Click on the OK button on the main color preferences window
   » The HSB window uses a slider bar to choose a color. Here’s how:
     - Slide the bar up or down until the color is correct

Or
1. Move the small white circle until the required mix is achieved
2. Click on the OK button on the HSB window
3. Click on the OK button on the main color preferences window
   » The RGB window uses three slider bars to choose a color. There is one for each of the colors, red green and blue:
   1. Slide each bar to the right or left until the color area is correct
   2. Click on the OK button on the RGB window
   3. Click on the OK button on the main color preferences window

**Resizing the Windows**
You can resize the windows on Switchboard’s screen display. There are two main window dividers. One separates the Active Calls area from the Reminder/Notebook area below it. Another divider separates the Directory area from the two other areas.

**To move either divider:**
1. Move the mouse pointer over the divider and when it changes to a double-headed arrow.
2. Click, hold and drag the divider to the required location.
**Miscellaneous System Numbers**

The following numbers are to access different extensions not associated with employees.

- **555: Voicemail:** This is the internal number you call from your extension to access Voicemail.

- **556: Conference Bridge:** The conference bridge is a reservation bridge that users of the system can schedule conference bridges for internal and/or external use.

- **444: Auto-Attendant:** This is the internal number you could call or transfer a caller to reach the Auto-Attendant allowing, menus including dial by name 1, dial by extension 2, company directory 4, or 500 to reach Voicemail. This is also the greeting someone will get when they call your company and someone does not answer.

- **500: Access Voicemail:** This number can be reached from the outside through the attendant to access your Voicemail.

- **559: Company Voicemail and Auto-Attendant recording:** Extension 559 changes require a system password. Default password will be 388045 it is recommended that it is changed.

- **601-605:** Park Extension Range: These numbers are used to park a call without transferring it to a specific extension. A parked call can be picked up from any extension phone on the system.
WARNING
Toll fraud is committed when individuals unlawfully gain access to a customers telecommunication system. This is a criminal offense. Currently, we do not know of any telecommunications system that is immune to this type of criminal activity. 8x8 Inc. will not accept liability for any damages, including long distance charges, which result from unauthorized and/or unlawful use. Although 8x8 Inc. has designed security features into its products and services, it is your sole responsibility to use the security features and to establish security practices within your organization, including training, security awareness, and call auditing to eliminate security risks.

NOTICE
While every effort has been made to ensure accuracy, 8x8, Inc. will not be liable for technical or editorial errors or omissions contained within the documentation. The information contained in this documentation is subject to change without notice. This documentation may be used only in accordance with the terms of the 8x8, Inc. License Agreement.

8x8, Inc.
Contact Information
• Personal Web Page: http://www.8x8.com

Support:
• http://www.8x8.com/support
• Customer Service, toll free: 1.888.898.8733
• Customer Service, outside of the U.S.: 1.408.687.4120

The 8x8, Inc. logo are registered trademarks of 8x8, Inc. 8x8, Inc. is a Nasdaq listed company, symbol EGHT.
© 2009. 8x8, Inc. All rights reserved.  corp09209